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Introduction

This document is intended to guide you through a few basic tasks in IBM® Rational®
Focal Point: from setting up a simple module, through prioritization and visualization, to
printing. By following the Cars example in this guide, you can learn to use the basic
decision-making features of the product and to analyze and draw conclusions from the
results. You can learn how to add a module that contains information about cars, add
some cars, prioritize them according to design and cost, and then see which one is best
according to certain criteria.

To better understand the tasks in this guide, note these basic concepts:

Module — The repository in which you store all information is structured in a
number of modules. Different types of information are handled in different
modules. A module contains elements, and all elements within the same module
share the same set of attributes. Build a module for each type of information, and
use different modules for different levels of information.

Element — Each module contains elements. For example, a module called Cars
contains the elements Car 1, Car 2, Car 3, Car 4, Car 5, Car 6, and Car 7.

Attribute — All elements are composed of a set of attributes. For example, the
element Car 1 contains the attributes ID, Title, Description, Type, and Price.

View — A view is a way of displaying information that is stored in the repository
(the modules). Only administrators have access to the repository — normal users
only see information through views that the administrator creates. For Rational
Focal Point, a view is what the user is allowed to see; a view normally contains
only a subset of the information in the repository. For example, a view can be
defined to display only elements that have a New status, or all elements that have
been assigned to a certain user.
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Prerequisites

To complete the tasks in this guide, you must be the administrator for a workspace in
Rational Focal Point. You can use either an installed local version of the tool on your
computer, or a hosted installation. The example and screenshots in this document are
based on a fresh workspace, with no other modules than the ones that are created
automatically with a new workspace. However, to complete these tasks, you do not have
to use an empty workspace; the module in the example can be created in any workspace.

The screenshots in this guide are based on Rational Focal Point version 6.4.1.
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Creating a module of elements

Create a module that can contain the elements to manage. You must be a workspace
administrator to create and change a module. When you create a module, you choose the
information attributes (for example, size, speed, and status) that you want the elements to

contain.
To create a module:

1. Inthe navigation bar, click Configure and then click Modules.

;’i‘“ Rational Focal Point

Workspaces | Home | Preferences | Mikael Norbéck | Help | Log Out

B

Modules
Reports

Members
Information
Advanced

About Focal Point

Getting Started |~ |

Welcome to IBM® Rational® Focal Point™ 6.4

IBM® Rational® Focal Point™ has been further enhanced to support your daily work. Take

a minute and read about what's new!

Workflow Support

The workflow feature helps your users
to more easily apply to the process.
You can now enforce your process in
Focal Point by limiting your options
when vou transfer an element from one
state to another.

Web Services 2.0

With the new version of web services
there is now support for all attribute

types in Focal Point. You will also be

able to use aliases and to access the
modules directly and not only via the
views.

®

Visit our Support Website

The web site contains Focal Point

information and download installation files

and user documentation.

Trend Charts

Focal Point now supports trend charts for one or
several attributes. This will help you to quickly see
the long term trend of for example cost and
revenue for a product or see burndown charts of
hours spent on implementing a particular task.

Filter Enhancements

The popular filter feature has been improved even
further to include functionality such as advanced

filters, the possibility to create filters from statistics
selection and to filter on range of integer and float

values.
Proceed °

Configure this page

This page can be customized e.g. to a user
or a project.

[T sottware

|»

A list of all of the available modules is displayed. (You might have other modules in
your list than those shown in the image.)

© Copyright IBM Corp. 1997, 2009
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2. Click the Add Module button.

uf" Rational Focal Point Waorkspaces | Home | Preferences | Mikael Norbiéck | Help | Log Out

Configure > Modules G arted g

EE;"" i Click the module you want to configure, or click Add Module to add a new n
i module.
ules
= == Name Add Button Name Description May Be Configured By
epo
L 5 Elements Element A module where the members  All Administrators % =
Configure add and organize any kind of
[ Workspace elements. When a new module
[Z/Modules is added to the workspace itis
E Aty bt always of this type.
= %2 Criteria Criterion The module where the members All Administrators @
[T views add and organize criteria.
o0 Notifications Criteria are used when
@Intagrations members prioritize elements or
"‘jAI criteria.
D Alias = T =
s %= Releases Release The module where releases are  All Administrators z |3
i Workflows stored. The releases are the
Members prerequisites when release
. plans are generated by the
Information release planner.
| Advanced = Saved Baseline The meodule where baselines are All Administrators =~
Baselines stored.
5 views View A module where the members  All Administrators &
add and organize any kind of
elements. When a new module
is added to the workspace itis
always of this type.
] Checkpoints Checkpoint The module where the members All Administrators @
add and crganize checkpoints. =
Checkpoints are used when the
members review elements.
3% Resource Resource Type  The module where resource All Administrators —
Types types are stored. The resource
types can be prerequisites when
release plans are generated by
the release planner.
I saved Chart The module where saved charts All Administrators &
Charts are stored.
@ Saved Report A module where generated All Administrators @
Reports reports can be saved.
K Add Module 3 Import Module |
Rational. £ iE]

3. Enter a name for the new module, a label for the Add button that will be displayed
later, and a short description of the module.

ational Focal Poin Workspaces | Home | Preferences | Mikael Norbick | Help | Log Out
Rational Focal Point k kael Norbiick | Hel

Configure > Modules Getti ed

| Enter information about th module, and click OK.

Modules Name |
Reports Add Button Name
Configure . ————————
Alias B z B z
Tl Workspace |58226cc0-4951-40a1 b¢51__f_ 4cs01e7
[/ Madules Description This is my cars modul
[EAttributes
3 views
o Notifications
@Integratlons
51 Alias
4+ Workflows B
Position in Module List Last |_\_¢_I
Members . —
Prefix Attribute hin]

Information
Icon Attribute -

. Advanced -
Sort Attribute -
Display Folder Icons [
Default Icon Click to select another icon.
May Be Configured By [ Members
§ []Mikael Norback
Disable Delete |

Hide Add Views In Menu [7]
Hide Module O

Baseline Version Control [ None

5 software
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4. Click OK. A window opens and displays a message about defining the attributes for
the module. Click OK.
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Adding attributes that describe the elements

After you create the module, you will see a list of the pre-defined attributes. For the
purposes of this example, you need to add two more attributes to provide information
about the type and price of the car.

To add attributes:

1. Add the Type attribute, which is a typical choice type of attribute because the
selection can be only one of a predefined set, in this case either Sports, or Sedan, or
Estate. Click Add Attribute, and then click Choice.

SI& Rational Focal Point Waorkspaces | Home | Preferences | Mikael Norbdck | Help | Log Out
Configure > Attributes in Modules Getting Started ﬂ]
_EL'_ | Cars: Click the attribute you want to configure, or click Add Attribute to add a new

attribute.
Modules
Administrator
Reports MName Description Notes Type Leg Changes Mandatory
Configure D Unigue 1D Unigue id Yes BX:z
[ Workspace - -
= Madul Title A short and concise Text Yes F(g %
ry) Mrh e explanation of the -
|ZaAttributes element.
EV\EWS Description A thorough Text Yes E ’ %
o Natifications explanation of the
: element.
(i Integrations ; =i X
= Al Element Heading e
EdAlias Information =
+5 Workflows Owner The user owning the Element E L]
Members element. Information
Information Creator The user creating the Element B -
| element. Information
Advanced
Created Date  The date the element Element B -
was created on. Information
Last Changed The user last changing Element E -
By the element. Information
Last Changed The date the element Element E -
Date was last changed on. Information
Parent Folder  The parent folder of Element E -
the element. Information

[ < Back (Md Attnbute_‘D [ Configuration Overview

[T sottware
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uf" Rational Focal Point

Configure > Attributes in Modules

Warkspaces | Home | Preferences | Mikael Norbdck | Help | Log Out

Modules
Reports
Configure

[ workspace

(eI Modules

[EuAttributes

E views

g Notifications

@Integratinns

SlAlias

++ Workflows
Members
Information
Advanced

You may add the following attributes to this module

Check box A box that a member can select or clear to turn an option on or off.

Choice A list of predefined items that a member may select a single item from
(e.g. status).

Date A date value (for example 3/31/2010).

File A document, image or other file in the database, or a list of such files.
Maximum total size is 50 MB.

Float A real number that contains a fractional part (e.g. 3.14).

Heading An attribute consisting only of a title, used primarily for layout purposes.
History History can display attribute or element history for an element.

Incoming Links A list of elements that link to this element.

Integer A real number that contains no fractional part (e.g. 42). 5
Link: A link from one element to ancther. The target can be either in this

workspace, or in another workspace.

List (text or link) A list is a collection of either text attributes or link attributes.

Matrix A n;atrix attribute consists of several text, float or integer attributes in a
grid.

Mirror A mirrored value of another attribute in another element.

Multichoice A list of predefined items that a member may select multiple items
from.

Text A text field where a member enters and edits text.

Time Grid Use this for calculations based on a time line.

URL A link to a specific resource on the Internet (e.g. http://www.ibm.com). L

Unique id A text field where the value must be unique. When new elements are
created, the unique id attribute is automatically assigned a unigue value.

Version A number or character that automatically increases based on changes in

other attributes.

You may add the following special attributes to this module

Lock A selection of attributes that can be locked from editing. When the lock
attribute is activated for an element the attributes selected in the lock

attribute cannot be edited and the element cannot be deleted. u

[T sortware

2. Edit the name and the description of the attribute, and then add choice items by

clicking the link next to Items.

&[® Rational Focal Point

Configure > Attributes in Modules

Workspaces | Home | Preferenc Mikael Norback | Help | Log Out

Modules
Reports
Configure

[ Workspace

[ Medules

|ZaAttributes

B views

g Notifications

(Integrations

SHAlias

+ Workflows
Members
Information
Advanced

Cars: Add Choice attribute

General Settings

Mame

Alias ae-056400ab9d

Description

Administrator Notes [

Position Before

Value Settings
Default Value
Items

Visual Settings
Sort Alphabetically

Allow Group By

Propagate Settings
Propagate |:|
Cascade Settings
Cascade Nu

Display Parents E

Item Separator [2 |

Mmoo s € ki e

[T sortware
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3. Add three items: Sports, Sedan, and Estate.

Add Choice Item

Mame |S|JDI"|:5 |

Description | |

Position

Ican

Click to =elect another icon.

Your list should look as follows:

Click an item to edit it, or click Add Item to add
a new item.

Name Description

Sports -
Sedan oo
Estate o =

4. Return to the list of attributes by clicking OK twice. Note that the Type attribute is
last in the list. You can move the attribute by clicking the arrows in the list. Move the
Type attribute above Element Information.

4_';1‘."' Rational Focal Point Workspaces | Home | Preferences | Mikael Norbdck | Help | Log Out
Configure = Attributes arted
EL': | Cars: Click the attribute you want to configure, or click Add Attribute to add a new
attribute.
Modules
Administrator
Reports MName Description Notes Type Leg Changes Mandatory
Configure D Unigue 1D Unigque id  Yes BX:z
[ Workspace = 4 3 - m P
P Title A short and concise Text Yes i
[/ Madules explanation of the *
|ZaAttributes element.
[ views Diescription A thorough Text Yes BHs
& Notifications explanation of the
4 g element.
(B Integrations 7 7 =T RS
: emen ieading
Efalias Information i
= Workflows owner The user owning the Element BXe
Members element. Information
Information Creator The user creating the Element BXe
element. Information
Advanced
Created Date  The date the element Element BXe
was created on. Information
Last Changed The user last changing Element E X2
By the element. Information
Last Changed The date the element Element E X2
Date was last changed on. Information
Parent Folder  The parent folder of Element E X2
the element. Information
Type Type of car Choice
[ < Back ][ Add Attribute ] [ Configuration Overview
LELEIN software
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5. Add the Price attribute. This is a typical integer. Click Add attribute and select
Integer. In the Name field, type Price, and in the Description field, type The
price of the car. Move the Price attribute above Element Information.

You now have a module that contains elements representing car information:

SI& Rational Focal Point Waorkspaces | Home | Preferences | Mikael Norbdck | Help | Log Out

Configure > Modules Getting Started ml

= . i [V it Ty 3o

|:E%,._ plans are generated by the =
L . release planner.

Modules Saved Baseline The module where baselines are All Administrators

Reports Baselines stored.

Configure B Views View A medule where the members  All Administrators
6 Workspace add and organize any kind of
B elements. When a new medule
[/ Medules is added to the workspace it is
@.Attributes always of this type.
[ views W Checkpoints Checkpaint The module where the members All Administrators
add and organize checkpoints.
Checkpoints are used when the
L-_{)Integrations members review elements.

SHAlias 4§ Resource Resource Type  The module where resource All Administrators
15 Workflows Types types are stored. The resource

types can be prereguisites when

Members release plans are generated by

the release planner.

Saved Chart The module where saved charts All Administrators
Charts are stored.

b
aw

av

ar

g Notifications

4qr

. Information
Advanced L

qb

@ Saved Report A module where generated All Administrators
Reports reports can be saved.

{§ Members Member Users in the database must be  All Administrators
members of a workspace to be
able to access the workspace.
All members of the workspace
are listed in this module.
Members get access to the
elements in the modules via
views. Members that also are
administrators also have access
to the modules.

4| 4Ap

3 Saved Plans Plan The module where release plans &Il Administrators
are stored. A release plan
contains the results of a
member's work with the release
planner.

Al

B cars Car This is my cars module. All Administrators Xeijs L
|»

[ Add Module ][ Import Module ]

[T sottware

6. In the left navigation bar, click Modules and then click Cars. The tree view of cars
opens. To add cars to your module, in the bottom frame, click the Add Car button.
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‘?Ia Rational Focal Point Workspaces | Home | Preferences | Mikael Norbdck | Help | Log Out

Modules = Cars

Getting Started gl

Bl | Cars ZaEs
Modules iz El
Elements Title Cars =R 4
& Cri e
* Criteria Description 7
% Releases
i Type Sports 7
¥ Checkpoints V_D B Z
{1 Resource Types Prien ’ 7
[E Cars Element Information
Owner j
i Saved Plans Creator Mikael Norback
lisved Chare Created Date 2009-11-18
|| Saved Reports -
. Last Changed Mikael Norback
= Saved Baselines By
Reports Last Changed 2009-11-18
Configure Date
Members Parent = ''  Cars
Information
Advanced
([ Add car [ Add Folder | [_Impoert Cars |
—
LELIE1 A software

Adding elements
1. Add the following cars by entering the Title, Type, and Price attributes for each as

follows:

Title (make) Type

Price

Carl Sports

10000

Car 2 Sedan

13000

Car 3 Sports

26000

Car4 Estate

14000

Car5b Sedan

18000

Car 6 Estate

20000

Car7 Sports

28000

Confirm each addition by clicking OK.

Getting Started with IBM® Rational® Focal Point™ 13(41)



After you add the cars, you will have a module with 7 elements:

ﬁi:' Rational Focal Point Workspaces | Home | Preferenc Mikael Norbdck | Help | Log Out

Getting Started

'!7-1 009:Car 1 Cars e
Modules 5 002:Car2 (o] =
[EElements 003:Car3 Title Cars = 7
% Criteria 004:Car 4 —
HiReleases 00%:Car 5 Bescription Erd
] Checkpoints B oog.Carg Type Sports 7
i Resource Types BUy:Eart Price ? 7
[E Cars Element Information
Owner - ,f
FeSaed Bk, Creator Mikael Norback

liu Saved Charts
Saved Reports
= Saved Baselines

Created Date 2009-11-18
Last Changed Mikael Norback
By

Heports Last Changed 2009-11-18
Configure Date
Members Parent Folder Cars

Information
Advanced

[ Add car | [ Add Folder | [ Import Cars |

[T sortware
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Creating a view of the elements

So far, you have worked with the Rational Focal Point repository directly. In the
repository, you can add, delete, and change elements, but to explore more features of
Rational Focal Point, you must define a view of the elements. Unless you are a
workspace administrator, you do not have direct access to the repository; you must access
the repository through views that are defined by the administrator. Views define what the
user is allowed to see.

You can define views that show many subsets of your information; for example, only
Estate cars, only cars that cost less than 20,000, or only those that a specific user created

after a specific date.

To create a view that shows all of the elements:

1. Click Configure > Views, and then click the Add View button. In the Title field,
enter ALl cars; in the Description field, enter This view shows all

elements

| a‘P Rational Focal Point

Configure > Views

Modules
Reports
Configure

[ Workspace

[z5lModules

[EuAttributes

[ Views

o Notifications

(i Integrations

GiAlias

+» Workflows
Members
Information
Advanced

D
Title

Description s

Mandatory Attributes

View
Definition

Display
Add
Review
Prioritize
Visualize
Plan

Criteria
Baseline

Access Information

First

Enter information about the new View, then click OK.

in the Cars module.

Workspaces | Home | Preferences | Mikael Norbdck | Help | Log Out |

Getting Started ﬂ

E£EE

All cars

il
-3

| [@[w] 2] [B] 7 [u]=|[=]=

i

S

his view shows all elements in the Cars module]

The sttribute cannot be edited in this frame.

Include this view in the Display menu.
[ Include this view in the Add menu.

[ include this view in the Review menu.
[ 1nclude this view in the Prioritize menu.
[ 1nclude this view in the Visualize menu.

[ 1nclude this view in the Plan menu.
Click To Add Link

]

|

[ETE R sottware

2. Do not modify the other attributes. Click OK. A list of available modules is
displayed, in which you define what module the view applies to:
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‘?Ia Rational Focal Point Workspaces | Home | Preferences | Mikael Norbdck | Help | Log Out

Getting Started gl

EM| | | Click the module from which you want to view elements.
Modules Name Description
Displa Elements A module where the members add and organize any kind of elements.
play Wwhen a new module is added to the workspace it is always of this type.
Beponts Criteria The module where the members add and organize criteria. Criteria are
Configure used when members prioritize elements or criteria.
[ workspace Releases The module where releases are stored. The releases are the
(=5 Modules prerequisites when release plans are generated by the release planner.
[EnAttributes Saved Baselines The module where baselines are stored.
T&V\ews Views A module where the members add and organize any kind of elements.

o0 Notifications When a new module is added to the workspace it is always of this type.

(g Integrations Checkpaoints The module where the members add and organize checkpoints.
= Checkpoints are used when the members review elements.

i Alias
i WorkTlon Resource Types The module where resource types are stored. The resource types can
ittt ] be prerequisites when release plans are generated by the release
Members planner.
Information Saved Charts The module where saved charts are stored.
Advanced Saved Reports A module where generated reports can be saved.
Members Users in the database must be members of a workspace to be able to

access the workspace. All members of the workspace are listed in this
module. Members get access to the elements in the modules via views.
Members that also are administrators also have access to the modules.

Saved Plans The module where release plans are stored. & release plan contains the
results of a member's work with the release planner.

This is my cars module.

Cancel

LELIE1 A software

3. Inthe list of Modules on the left, click Cars. A wizard opens to guide you through a
series of steps. The first in this series is a general selection rule:

Define the rule, then click OK.

Show elements whose |tVIJE is a folder vl

15 Falze

For tips on how to define view rules, refer to the online help.

This rule means that the view shows the elements that are not folders. Accept this
default setting and click OK.

4. Click Next. A window opens in which you can define what attributes are visible and
editable through the view:

Getting Started with IBM® Rational® Focal Point™ 16(41)



6.

;_’;f" Rational Focal Point Workspaces | Home | Preferences | Mikael Norbdck | Help | Log Out

Getting Started n

EE%*' Define the access level for the attributes in All cars, then cdlick Finish.
Administrator
Modules None VWisible Editable Attribute Drescription Notes Type
Display o ® 1D Unique ID Unique id
R ris : =
Epur © ® Title A short and concise Text
Configure explanation of the element.
@ Workspace [O] © (3] Description A thorough explanation of the Text
[ Modules element.
[EaAttributes o o @®F Tvpe Type of car Chaoice
EV'EWS (@] (] ® Price The price of the car. Integer
o0 Notifications = g = T
E emen eadin
(gIntegrations o @ Information :
7 Alias o] ® o] Owner The user owning the element. Element
<+ Workflows Information
Members [O] ] Creator The user creating the element. Element
| ir e Information
nformation
[O] ] Created Date  The date the element was Element
Advanced created on. Information
1O ] Last Changed The user last changing the Element
S By element. Information
© ® Last Changed The date the element was last Element
Date changed on. Information
© ] ® Parent Folder  The parent folder of the Element
element. Information
= = [= Use the arrow buttons to assign access for all attributes.
Miscellaneous settings
[ Allow elements to be turned into folders and folders into elements when using the Display menu.
Use the following workflow for this view: | --- No workflow --- L\'I

Rational. BV ED

Because you do not need to use all of the administrative attributes, hide the attributes
that you do not want to use. For each attribute, select either None, Visible, or
Editable, as shown in the above image.

Return to the tree structure of the views by clicking Finish. The view definition is
shown: “All elements in the Cars module whose type is a folder is false.”

According to the default behavior, the view is visible in Display menu section. To
show the contents of the view that you created, click Display > All Cars.
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Displaying the elements

Rational Focal Point has several powerful display modes that are useful in various
situations. One common display mode is the tree view, which you have seen in the
example about the Cars module (the repository). However, if you use the view definition
that you created, some of the attributes are hidden in the tree view.

ﬂ:ﬁ Rational Focal Point Warkspaces | Home | Preferences | Mikael Norbick | Help | Log Dut

Display > All cars Getting Started |~ |
Exd EEH HIE & 2% 6| nlF
- Cars{1/7) E—
"Dd':'es e 001 Car i} Cark R
Display = =
Al gars B DDQICarE (3 001 E}
003:Car3 Title Cari 7
Reports oo04car4
Configure 005:Cars Type Sports 7
Members -5 o06:Car6 Price 10 000 Vd
Information 18 007:Car7 Element Information
Advanced Owner Mikael Norback
Last Changed 2009-11-18
Date
Parent Folder  Cars v
[T software

You can use these display modes:

EBE X IE &% @O

From left to right, the modes are Tree, Table, Relational graph, Attribute
statistics, Traceability Matrix, Gantt, History, and What’s New. Not all of these
modes are used in the Cars example.

Table

In Table mode & , You get an overview of all the elements and the visible attributes. You
can also sort elements according to an attribute. To sort the elements alphabetically
according to Title, click Title.
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4_';1“'" Rational Focal Point Workspaces | Home | Preferences | Mikael Norbdck | Help | Log Out

Display = All cars Getting Started gl

2| EE# E &1 28 QS0P
Modules ID * Title Type Price Owner Last Changed Date Parent Folder
Display 001 Carl Sports 10000  Mikael Norback 2009-11-18 Cars
R 002 Car2 Sedan 13000  Mikael Norback 2009-11-18 Cars
Reports 003 Car3 Sports 26000  Mikael Norback 2009-11-18 Cars
Chnfugure 004 Card Estate 14000  Mikael Norback 2009-11-18 Cars
Memhers 005 Cars Sedan 18000  Mikael Norback 2009-11-18 Cars
Information 006 Car6 Estate 20000  Mikael Norback 2009-11-18 Cars
Advanced 007 Car7 Sports 28000  Mikael Norback 2008-11-18 Cars

Maximum number of elements per page
50 [v]

Export All cars | [ Update Cars | [ Tree View Sorting |

LELIE1 A software

Relational graph

In a Relational graph ¥ , you can see all relationships between the elements: either
structural (for example, by type of car, as in the next image) or linked. To use this view,
note the settings in the bottom frame of the following image:
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Display = All cars Getting Started gl
B EERE 4B QdIBID
Modules
Display
[EAll cars
Reports
Configure E car7
Members
Information 8 caa e
=] carz
Advanced
[ pors)
= Ccals
SRR e
[ Estats]
Browse Attribute Layout Text Depth Mode Width  Display Links
Type Iil Balloon \i.[ 3 [a] [Medium [»] [
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Attribute statistics

The Attribute statistics mode = summarizes facts about your elements; for example,
how many cars are Sports cars, how many of your requirements have the New status, or
how many requirements are currently in a particular status of development.
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uf‘ Rational Focal Point

Display = All cars

Warkspaces | Home | Preferences | Mikael Norbdck | Help | Log Out

Getting Started

]

Modules
Display

All cars
Reports
Configure
Members
Information
Advanced

B B RIE S RS BRI P

Type Quantity Share

Sports 3 42,9% I

Sedan 2 28,6% I

Estate & 23,6% ]

Sum: 7
Row Column Cell
iType, E |- None —- ‘Q' Number of Elements M [ rlain text
[T software

Traceability matrix

The Traceability matrix

o

shows the relationships between elements:

sl af
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Total number of Links: 23
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B H o & E g K E
.ﬁ.va{%vﬂmﬁoﬁmm

od Jddd o dd 11
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Note: This example is based on data that is not used in the Cars example.
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Gantt

The Gantt mode ™= is useful when the time dimension is important, such as when a set
of release projects should be viewed:

-
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W& crag D007 Cuieter metar | . ]
1
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1
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'
L{ ¥ a7 Gikwroara Biln-alFlu:

1
[ ureaDEd: 1500 dppimiduis
i

1

Piech
O F Targel Stat Dale
©F Flanned Start Dat
O Aoy Sist Dale
i = Targel Concapt D
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& ¥ soual Concept D

P Tarege Digsbipemn
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@7 Target End Diate
& Flanned End Date
& F asual End Date
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¥ Cieglest Cuile
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Note: This example is based on data that is not used in the Cars example.

History

. O . . .
The History mode = shows the history of an attribute; for example, how Choice
attributes have changed over time. The following example shows how the Status attribute
of a set of requirements have changed. You might use this information to make
conclusions about the development process:
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From To Number of Times Number of Elements Averaga Time
e L uDraft 13 12 497
g o By 72 23 2776
ey w spproved 11 g 328
weMaw @ complatad 3 3 270
L VT f#51n Progress & [ 60
ey Awithdrawn i i <1
W aw = Reviewed 12 10 457
auDraft A withdrawn 1 1 329
2 Draft @ Completed 1 1 145
asDraft gy 7 7 £20
= Draft " Approved 1 i b3 |
aaDraft = Raviawid 4 4 162
 Reviewad oy 14 12 2273
= Agvigwad anDraft 1 1 2283
™ Reviewed w Approved 2 2 138
w Bpproved S completad 1 21
w hpproved B withdrawn 1 1 23
¥ Approved By 14 10 1978
w hpproved ##In Progress 2 2 509
£3In Progress = Ravigwed 1 1 19
##1n Progress nru B 4 4 4633
£2In Progress @ completed 3 3 523
@Complated @rostponed 1 1 1612
@completed Ll 4 4 4190
@ Complated w Approved 3 3 73
@rostponed 2 withdrawn 1 1 43
®©rostponad new g i 1 3357
P withdrawn Brostponad 1 y 338
B withdrawm w* Approved i 1 308
& withdrawn e NEw 2 2 2137
Time s displayed in hours.

Typa Attrbuts Py Epac tive

Mumber of Changes »

Note: This example is based on data that is not used in the Cars example.
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What's New

The What’s New mode & can be used to spot changes that, for example, were made
since you last logged out. In the following example, the What’s New mode shows
changes made to the Type attribute in the last 8 hours:

L'iﬂ Rational Focal Point Waorkspaces | Home | Preferences | Mikael Norback | Help | Log Out
Display = All cars Getting Started gl
- E B RE &R QDB P
Hodules What's New in All cars?
Dil:\?’cars Date Member Element Attribute Changed To
2009-11-18 13:40 Element added by Mikael Norback. 007:Car 7 ID 007
Keports 2009-11-18 13:40 Element added by Mikasl Norback. 007:Car7  Title car7
Confhyuce 2009-11-18 13:39 Element added by Mikael Norback. 006:Car6  ID 006
Hembers 2003-11-18 13:39 Element added by Mikael Norback. o06:Cars  Title cars
infarmation 2009-11-18 13:39 Element added by Mikasl Norback. 005:Cars  Title cars
fdvancad 2009-11-18 13:39 Element added by Mikael Norback. 005:Car5  ID 005
2009-11-18 13:38 Element added by Mikael Norback. 004:Car 4 Title Car 4
2009-11-18 13:38 Element added by Mikael Norback. 004:Car 4 D 004
2009-11-18 13:38 Element added by Mikael Norback. 003:Car 3 Title Car 3
2009-11-18 13:38 Element added by Mikael Norback. 003:Car 3 ID 003
2009-11-18 13:38 Element added by Mikael Norback. 002:Car 2 ID 002
2009-11-18 13:38 Element added by Mikael Norback. 002:Car 2 Title Car 2
2009-11-18 13:37 Element added by Mikael Norback. 001:Car 1 Title Car1l
2009-11-18 13:37 Element added by Mikael Norback. 001:Car 1 ID 001

Displaying changes since 2009-11-11 14:34 CET. 53

Time Scope Member Scope Attribute Scope
[Last week [x] [All Members [v] |l atributes [v] o
Rational. EL IV Gl
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Creating criteria for prioritizing your elements

With Rational Focal Point, you can prioritize elements in a structured way. For example,
many situations in product management or requirements management require that you
make decisions based on your information. For instance, which features should go into
the next release? What risks are most severe? What competitors constitute the largest
threat?

While some attributes, such as Price and Type, are represented by facts, some attributes,
such as design, are more relative. In this example, you create two criteria: Design and
Price. Use these criteria to compare the cars.

To create the criteria:
1. Click Modules > Criteria, and click Add Criterion.

2. Enter a name and short description for the criterion. Make sure the Objective is set to
Maximize, because this is a positive criterion.

3. Inthe Question field, type a question that illustrates this criterion; then click OK.

| —
ﬂ:ﬁ Rational Focal Point Warkspaces | Home | Preferences | Mikael Norbick | Help | Log Out |
Modules > Criteria Getting Started |~ |
n = Criteria( 110) 5 ; — ; |
=7 Enter information about the new Criterion, then click OK.
Modules IF] ik
Elements Title Design appeal
%_ Criteria Brescripti
= ption b | p == | =l =
“ Releases sty | Z BT U || |1=]52] [GE|E M
[v] Checkpoints his criterion represents the subjective appeal of the design of the

m}REsuur:e Bibes car, in short, how good it looks.

|Z cars

S saved Plans

liy Saved Charts
[y Saved Reports
—=5aved Baselines

| Displa P =
m‘(cars Ohfective T [Maximize [v] |
Reports
Configure Type e [ Fublic |V‘
Members
Information -
Advanced Question Which car looks better?|
Estimate The attribute cannot be edited in this frame.

Element Information

Owner Mikael Norback [w| Lookup
Creator Mikael Norback

Created Date  2009-11-13

Last Changed Mikael Norback

By

Last Changed 2009-11-18

Date 1

____________ 12
LELLAE Y software
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4. Create a Price criterion. Because you know the price of each car, you can use those
numbers. From the Objective list, select Minimize; then click OK.

4_';1“" ﬁationaﬁacal Point Waorkspaces | Home | Preferences | Mikael Norbdck | Help | Log Dutr
Modules = Criteria Getting Started gl
E%' | é ”11 appeal| i information about the new Criterion, then click OK.
Modules il i
Elements Title Price |
#_ Criteria Description I A I A I M = BIEEE

% Releases
¥ Checkpoints he criterion is based on the Price attribute in the Cars module.

Resource Types
] vp
[E Cars

Sk Saved Plans

liu Saved Charts
|| Saved Reports
= Saved Baselines

Dil:r Objective
cars

Reports

Configure Tvpe w4 [ Public [v]
Members e
Information %
Question
Advanced
Estimate The attribute cannat be edited in this frame.

Element Information

Qwner | Mikael Norback [w] Lookup
Creator Mikael Norback

Created Date  2009-11-18

Last Changed Mikael Norback
By

Last Changed 2009-11-18
Date

Gl | il [

LELIE1 A software

5. Set the link between the criterion and the Price attribute of the Cars elements by
editing the Estimate attribute. Click the edit icon #” next to Estimate.
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Warkspaces | Home | Preferences | Mikael Norbdck | Help | Log Out

> Rational Focal Point

Modules > Criteria

=2 Criteria( 112)

. £ E g
T 001:Design appeal | Price Re&Es
Modules o s =
Elements Title Price EV4
¥ Criteria Description The criterion is based on the Price attribute in the Cars =4
% Releases module.
[v] Checkpoints Objective J Minimize =4
E:Zume Types Type 4 Public EI f
Question EF
2% =aved Plans Estimate - EE

liu Saved Charts

Element Information

Owner Mikael Norback 7
= Saved Baselines
Creator Mikael Norback
Displa
= 2 rt‘_; Created Date  2009-11-18
epoi
= Last Changed  Mikael Norback
Configure By
picmbess Last Changed  2009-11-18
Information Date
Advanced Parent Folder  Criteria 7

(_Add Criterion | [_Add Folder | [ Turn IntoFolder | [_Delete | [ Import Criteria

[T sortware

6. Select Cars.

Workspaces | Home | Preferences | Mikael Norback | Help | Log Out

Rational Focal Point

Module: riteria

Modules
Elements
%_ Criteria
=, Releases
[¥] Checkpoints
{1 Resource Types
Cars

S saved Plans
Saved Charts
Saved Reports
= Saved Baselines

Display
Reports
Configure
Members
Information
Advanced

=) Criteria( 112 )
001:Design appeal

Select the module that contains the estimate attribute.

Elements

Criteria

Releases

Saved Baselines

Views

Checkpoints

Resource Types

Saved Charts
Saved Reports

Members

Saved Plans

A module where the members add and organize any kind
of elements. When a new module is added to the
workspace it is always of this type.

The module where the members add and organize
criteria. Criteria are used when members prioritize
elements or criteria.

The module where releases are stored. The releases are
the prerequisites when release plans are generated by
the release planner.

The module where baselines are stored.

A module where the members add and organize any kind
of elements. When a new module is added to the
workspace it is always of this type.

The module where the members add and organize
checkpoints. Checkpoints are used when the members
review elements.

The module where resource types are stored. The
resource types can be prerequisites when release plans
are generated by the release planner.

The module where saved charts are stored.

A module where generated reports can be saved.

Users in the database must be members of a workspace
to be able to access the workspace. All members of the
workspace are listed in this module. Members get access
to the elements in the modules via views. Members that
also are administrators also have access to the modules.

The module where release plans are stored. A release
plan contains the results of a member's work with the
release planner.

This is my cars module.

The attribute value is not set.

If this value is not set, pairwise comparisons determine the elements' priorities for
this criterion. If this value is =et, the values of the selected attribute determine the

Iv|

Rational. ELIUE ]
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7. Select the Price attribute (which is the only one available because there is only one
integer attribute in the Car element):

= I Criteriad 112 ) B . s
4 003:Dasign appeal Select Estimate Attribute for Price

1 004 Price Frice

If this value is not set, pairmise comparisons determing the elements’
prigrities far this criterion. If this valus iz set, the valuss of the sslected
attribute determine the priorties. The attribute must be in the same module
&2 the elements.

8. Inthe view that you defined, specify that all cars should be available for prioritization
and visualization. Click Configure > Views > All Cars.

SI"" Rational Focal Point Workspaces | Home | Preferences | Mikael Norbick | Help | Log Out
figure > Views Getting Started ﬂl
T = Visws(11) S
= 001:All cars] All cars BaB8s
Modules 2 e B
Display Title All cars = #
Reports Diescription This view shows all elements in the Cars module. E4
c"%ﬁ\ﬂ”f Mandatory Attributes
orkspace
DX “iew Definition All elements in the Cars module whose type is a folder is j
[z Modules folee E
Sy Attributes % X 1
& Visible attributes:
[ views
a0 Notifications * 1D
P * Title
(g Integrations » Type
GHAlias « Price
s WorkFlows * Element Information
2 * Owner
Members » Last Changed Date
Information * Parent Folder
Advanced Editable attributes:
» Title
* Type
* Price
* Parent Folder
Display Yes j
add No Vi
Revie: No i
( Prioritize No P
isualize No 7
Plan No 4
Criteria All criteria 4
Baseline No 7
Access Information ]
[ Add View ] [ Add Folder ] [ Turn Into Folder ] [ Delete ] [ Display View ][ Share View ][ Delete From M:
LELEIN software

9. Set the Prioritize and Visualize attributes to Yes by clicking their edit icons and
selecting the check box:

Prioritize Yes 7
Visualize Include this view in the Visualize menu.lal B 4

Lets the users wvizualize prioritization results and estimates in
chart=.

The Prioritize and Visualize menus are displayed in the navigation bar, and the All
cars view is available.
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By default, the criteria attribute is set to “All criteria,” so in this case, you do not need
to edit that attribute because you have only two criteria in the criteria module. In a
different situation, you might have many criteria for all sorts of element types. In that
case, you can select what specific criteria are relevant by defining a view of the
relevant criteria and linking this attribute to the view.

Prioritizing your elements

You can use the decision support features in Rational Focal Point to consider several
elements according to several criteria at the same time. You can focus on two
alternatives according to one criterion at a time, and then combine the simple choices to
present the larger and more complex situation.

To prioritize your elements:
1. Open the Prioritization view of All cars by clicking Prioritize > All cars:

[ T e e T T e T R R T e e |
613 Rational Focal Point Workspaces | Home | Preferences | Mikael Norbdck | Help | Log Out|
Prioritize > All cars Getting Started m
B fRle | = B | W | %
Modules =
Display
Prioritize
EjAll cars - — — . -
S Car6 ZEN F# S carl ZaR &
Visualize FA( J(k_ T i
Reports 1 i AL, E
Configure Title Caré F = Title Card Vs
Members Type Estate V4 Tyma =norts P2
Information Price 20 000 7 Price 10 000 7
Advanced Element Information Element Information
Owner  Mikael Norback Owner  Mikael Norback
Last 2009-11-18 Last 2009-11-18
Changed Changed
Date Date
Parent Cars 7 Parent Cars 7
Folder Folder
comment ¥
® & & & C @ ¢ o o
Completed: 0. Required: 6. Recommended: 13. Number of elements: 7. Comparison: 1.
Criterion w2ESi9n appeal (public) | v, [ Delete This Comparison | [ Delete All Comparisons |
[T sottware

Note a few things in this view. First, you are presented with a question that is based
on the criteria you are currently considering. Your task is to consider two elements (in
this case, Car 6 and Car 1) and indicate which one looks better by marking the scale.
If you think Car 6 looks better, place the mark to the left, and vice versa.

There are no units, and the scale is not absolute. Placing your mark to the extreme left
does not mean that Car 6 looks twice or three times as good as Car 1. The scale is
relative.
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2. Do the pairwise comparisons for the Design appeal criterion by selecting buttons on
the scale and clicking OK. After you makel3 comparisons, a message stating that
you can now visualize the result is displayed.
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Visualizing your results

You can use visuals to support your decisions. Priorities are represented as bars, bubbles,
and lines, with size and length relative to their priority.

To visualize priorities in a bar chart:

1. Click Visualize > All Cars. Make sure that the bar chart mode is selected.

GIa Rational Focal Point Workspaces | Home | Preferences | Mikael Norback | Help | Log Out:

Getting Started

Visualize > All cars

Modules
Display
Prioritize
Visualize

|2 All cars
Reports
Configure
Members
Information
Advanced

Eletk taagh = EHSS™ B2

*: Design appeal (Public)

¥ (=006 Car B
#2005 Cars \

7 2002 car 2 |

# £ 001 Car1
¥ E 007 Car 7

[ =1 003|Car 3
% =004 Car 4

| 1 1
10% 20% 30%
Design appeal (Public)

X Axis

Design appeal (Public) ||

[ETE R sottware

The bar chart shows one criterion. In the chart, Car 6 is better looking than Car 4. The
best cars according to a criterion are indicated by a green check box. The scale shows
relative design appeal in percentages, and the lengths of all bars sum up to 100%.

You can choose from several visualizations, and there are no guidelines about what
visualization techniques to use in what situations. For instance, in this example, you
might also use the stacked bar chart.

© Copyright IBM Corp. 1997, 2009 Getting Started with IBM® Rational® Focal Point™ 31(41)



2. To see the stacked bar chart, click the button.

B . e e ]
aT} Rational Focal Point Workspaces | Home | Preferences | Mikael Norbiick | Help | Log Out |
Visualize > All cars Getting Started n
B- ERkL LOoah ® a8 Bl
Modules 7 =
= ¥ Price (estimate)
Display 100% (129000
Prioritize W Design appeal (Public)
Visualize 1 00%
= Al
£ —¥— The triangles indic
Reports —a— atethelelement's t
Configure otal score
Members (Positive - Megative)
Information
Adranced Price ;Design appeal
[ ¥ [Z 006: Car 6
[ FE002Carz |
[ ¥ [ 005 Car & |
\ ™ |5 001: Cal 1
2 ¥ 2 004: Car 4
5 = %
[ i Il@ oo07: far 7
[ . ® =/ o3: car 3
[ET software

In the stacked bar chart, you can see more than one criterion at a time. In the figure
above, you can see that when you consider both cost and design, the relative rank is
different. Considering both criteria, the bar at the top is best and the one at the bottom
IS worst.

You might have many more criteria, such as Versatility, Environmental friendliness,
Safety, Build quality, and so on. Or, you might have more stakeholders that should be
represented. All these criteria can be shown at the same time in the stacked bar chart.

3. Analyze the chart: Select and clear some of the check boxes and see how the value
indicators in the top right corner are affected. As you select and clear the cars, the
value indicators reflect that you do not get all of the relative value (design) and the
relative cost.

In this example, the value indicators make little sense, but in other situations, the
indicators are useful. For example, if you were considering a set of features to
implement in a software product, you could use the indicators to see what features to
consider in order to get 60% of the value for 30% of the cost.

4. Consider what happens if the Price criterion is more important than the Design
criterion. In the right frame, right-click and select Criteria Scenarios:
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¥ Price {Public)

| 100% |
¥ Design appeal (Public)

| 100% |

Y The triangles indicate the
— & Eement's total score

(Fositive - Negative)

Show Priorities For Criteria

Criteria Scenarios
Show Rank Correlation

Select All Criteria
Clear All Criteria

The Criteria Scenarios window opens, in which you can try different scenarios. For
example, what if cost is twice as important as design?

5. Drag the Price slider to the right until the value is 80%.

SI& Rational Focal Point Waorkspaces | Home | Preferences | Mikael Norbdck | Help | Log Out
v ize > All cars Getting Started ﬂ]
=, | EgkEL L = HEe 2B R
Modules
rrody W Price (estimate)

St 100% (128000
Prioritize W Design appeal (Public)
Visualize 100%

Rl % The triangles indic
Reports —a— dtethelelement's t
5 otal scare
Configure
Hembers {Positive - Negative)
Information ) .
Aduaiiced ;Price - Design appeal
¥ (51008 Caré |
= nqz Car 2
[ N W E10]5: Car 5
=2 i 001 Card
[P Ein0a cars
[ =_ Il 007: Car 7
[ |F¢ Ej00a cara
[
|| Criteria Scenarios [;]
]
Drag the scrollers to change the criteria priorities
Lock
(gl 1 |»| 20% Design appeal (Publi
[l | [>] 80% Price )
i| Go backto the original prioriies
The criteria scenarios are not stored on the database.
When the Visualize frame is closed, the data is lost, | 4
5o, B

6. The black triangles - indicate the rank of the elements. To refresh the order of the
elements in the stacked bar chart, click :
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GIa Rational Focal Point Workspaces | Home | Preferences | Mikael Norback | Help | Log Out:

Visualize > All cars Getting Started nl
ERE L3 g =W EB&AR EIF

Modules
= W Price (estimate)
Disphay T00% (128000)
Enartze W Design appeal (Public)
Visualize 100%
BT % The trianales indic
Reports —a— atethelelement's t
o otal score
Membors (Positive - Negative)
Information
T ) ;Price Design appeal
' ¥ E/006 Card |
¥ =002 Car2
[ i  E|0gs: Car 5
Iz i 001: Car1
% E1004 car s
. W =007 car 7
o &
[ [ 2003 Car 3

[ETE R sottware

If you consider Price to be much more important than design, Car 6 is the best. This is
indicated because the black triangles on the Car 6 bar are the most to the right. Car 3
turns out to give the least design for the money. In other situations, you might
consider other issues, for example:

e What if I need to cut the budget—how would that affect my planning?
e How robust is my risk analysis?
You can experiment with these criteria to see the effects of such scenarios.

If you close the Criteria Scenarios window, the relative weight of the criteria is fixed.
You can change the weight of criteria by opening the Criteria Scenarios window.
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Printing a report

Rational Focal Point has a customizable built-in report generator. To create a quick

report:

1. Click Display > All cars, and click the ™ button. A window opens in which you can
enter basic administrative information:

& Focal Point - Mozilla Firefox

SEX

Select report format.
Format

Paper Size
Orientation

Use header, footer and font from template
(TPE templates are currently not available in quick reports).

RTF (Rich Text Format) [se]
A4 [a]
Portrait  [w

Basic Prioritization 1.0 [iae

Click Next.

& Focal Point - Mozilla Firefox

SET=

Header
E Header
B Table Cell Prepared by
E Table Cell Document number
E Table Cell Approved by
E Table Cell Checked
E Table Cell Reference
E Table Cell Date

(_Generate Report | [ Close |

Click Generate Report and follow the instructions.
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& Focal Point - Mozilla Firefox =Jo&d

Q The report was successfully generated.

Click here to view the report in your browser.

The report is not automatically saved (neither on your hard disk,
nor in the database).

To save the report on your hard disk, right-click
the link and select Save Target As....

L You are using a Mozilla-derived browser. You might have to
change file suffix to .rtf for the file to open in the correct
reader or editor.

To save the report in the database, you need to
upload the copy from your hard disk to the database.

Close

Summary and next steps

In this guide, you have learned how to create a module (Cars), add information
(attributes) about its elements (the cars), display the information in various ways,
prioritize the cars according to a couple of criteria (design and cost), analyze scenarios
about the cars, and print a report. These tasks are some of the most basic tasks that you
can do with Rational Focal Point. You can also use the product for these purposes:

Filtering, which you can use to filter relevant information. While views define what the
user is allowed to see, users can define filters to select a subset of a view.

Linking information together. Information elements are almost always linked to other
elements: products to customers to releases to markets to requirements, and so on. With
Rational Focal Point, you can link information and display relationships.

Business rules, which you can use for almost unlimited data manipulation; for example,
creating workflows, doing quality control, and notifying members by email about certain
events

Role-based access, so that product managers, developers, customers, and others can add,
change, prioritize, and display the information that is relevant to them

Release planning, by which you can select sets of requirements and link them to release
projects

Review support for information. For example, requirements can undergo a review
process within an organization to secure clarity, understanding, and quality.

Versioning and baselining, by which changes to information elements can be tracked
(and rolled back, if necessary) down to the attribute level

You are now ready to explore all the features of Rational Focal Point. As you explore,
use the help system by clicking the Help link in the top right corner.
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More information

Contacting IBM Rational Software Support

If the self-help resources have not provided a resolution to your problem, you can contact
IBM® Rational® Software Support for assistance in resolving product issues.

Note If you are a heritage Telelogic customer, a single reference site for all support resources
is located at http://www.ibm.com/software/rational/support/telelogic/

Prerequisites

To submit your problem to IBM Rational Software Support, you must have an active
Passport Advantage® software maintenance agreement. Passport Advantage is the IBM
comprehensive software licensing and software maintenance (product upgrades and technical
support) offering. You can enroll online in Passport Advantage from
http://www.ibm.com/software/lotus/passportadvantage/howtoenroll.html

e To learn more about Passport Advantage, visit the Passport Advantage FAQs at
http://www.ibm.com/software/lotus/passportadvantage/brochures fags gquickquides.h
tml.

e For further assistance, contact your IBM representative.

e To submit your problem online (from the IBM Web site) to IBM Rational Software
Support, you must additionally:

e Be aregistered user on the IBM Rational Software Support Web site. For details
about registering, go to http://www.ibm.com/software/support/.

e Be listed as an authorized caller in the service request tool.

Submitting problems
To submit your problem to IBM Rational Software Support:

1. Determine the business impact of your problem. When you report a problem to IBM, you
are asked to supply a severity level. Therefore, you need to understand and assess the
business impact of the problem that you are reporting.

Use the following table to determine the severity level:

Severity Description
1 The problem has a critical business impact: You
are unable to use the program, resulting in a critical
impact on operations. This condition requires an
immediate solution.

2 This problem has a significant business impact:
The program is usable, but it is severely limited.
3 The problem has some business impact: The

program is usable, but less significant features (not
critical to operations) are unavailable.

4 The problem has minimal business impact: The
problem causes little impact on operations or a
reasonable circumvention to the problem was
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implemented.

Describe your problem and gather background information, When describing a problem
to IBM, be as specific as possible. Include all relevant background information so that
IBM Rational Software Support specialists can help you solve the problem efficiently. To
save time, know the answers to these questions:

What software versions were you running when the problem occurred?
To determine the exact product name and version, use the option applicable to you:

1. Start the IBM Installation Manager and select File > View Installed Packages.
Expand a package group and select a package to see the package name and
version number.

2. Start your product, and click Help > About to see the offering name and version
number.

What is your operating system and version number (including any service packs or
patches)?

Do you have logs, traces, and messages that are related to the problem symptoms?

Can you recreate the problem? If so, what steps do you perform to recreate the
problem?

Did you make any changes to the system? For example, did you make changes to the
hardware, operating system, networking software, or other system components?

Are you currently using a workaround for the problem? If so, be prepared to describe
the workaround when you report the problem.

Submit your problem to IBM Rational Software Support. You can submit your problem
to IBM Rational Software Support in the following ways:

Online: Go to the IBM Rational Software Support Web site at
https://www.ibm.com/software/rational/support/ and in the Rational support task
navigator, click Open Service Request. Select the electronic problem reporting tool,
and open a Problem Management Record (PMR), describing the problem accurately
in your own words.

For more information about opening a service request, go to
http://www.ibm.com/software/support/help.html

You can also open an online service request using the IBM Support Assistant. For
more information, go to http://www.ibm.com/software/support/isa/faq.html.

By phone: For the phone number to call in your country or region, go to the IBM
directory of worldwide contacts at http://www.ibm.com/planetwide/ and click the
name of your country or geographic region.

Through your IBM Representative: If you cannot access IBM Rational Software
Support online or by phone, contact your IBM Representative. If necessary, your IBM
Representative can open a service request for you. You can find complete contact
information for each country at http://www.ibm.com/planetwide/.

Getting Started with IBM® Rational® Focal Point™ 38 of 41



Notices

This information was developed for products and services offered in the U.S.A. IBM
may not offer the products, services, or features discussed in this document in other
countries. Consult your local IBM representative for information on the products and
services currently available in your area. Any reference to an IBM product, program,
or service is not intended to state or imply that only that IBM product, program, or
service may be used. Any functionally equivalent product, program, or service that
does not infringe any IBM intellectual property right may be used instead. However,
it is the user's responsibility to evaluate and verify the operation of any non-1IBM
product, program, or service. IBM may have patents or pending patent applications
covering subject matter described in this document. The furnishing of this document
does not grant you any license to these patents. You can send license inquiries, in
writing, to:

IBM Director of Licensing
IBM Corporation

North Castle Drive
Armonk, NY 10504-1785
US.A.

For license inquiries regarding double-byte character set (DBCS) information, contact
the IBM Intellectual Property Department in your country or send written inquiries to:

Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan, Ltd.

1623-14, Shimotsuruma, Yamato-shi
Kanagawa 242-8502 Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states to not allow disclaimers of express
or implied warranties in certain transaction, therefore, this statement may not apply to
you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements and/or
changes in the product(s) and/or the program(s) described in this publication at any
time without notice.

Any references in this information to non-1IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
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sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.

Licensees of this program who wish to have information about it for the purpose of
enabling (i) the exchange of information between independently created programs and
other programs (including this one) and (ii) the mutual use of the information which
has been exchanged, should contact:

Intellectual Property Dept. for Rational Software
IBM Corporation

20 Maguire Road

Lexington, MA 02421-3112

US.A

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material available
for it are provided by IBM under the terms of the IBM Customer Agreement, IBM
International Program License Agreement or any equivalent agreement between us.

Any performance data contained herein was determined in a controlled environment.
Therefore, the results obtained in other operating environments may vary
significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurements may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of those
products, their published announcements or other publicly available sources. IBM has
not tested those products and cannot confirm the accuracy of performance,
compatibility or any other claims related to non-IBM products. Questions on the
capabilities of non-IBM products should be addressed to the supplier of those
products.

All statements regarding IBM’s future directions or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

If you are viewing this information softcopy, the photographs and color illustrations
may not appear.

Trademarks

IBM, the IBM logo, ibm.com are trademarks or registered trademarks of International
Business Machines Corp., registered in many jurisdictions worldwide. Other product
and service names might be trademarks of IBM or other companies. Other company,
product or service names may be trademarks or service marks of others.
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The following terms are trademarks of International Business Machines Corporation
in the United States, other countries, or both:

e IBM
e Rational
e Focal Point
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